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Before You Begin 
Refer to the Getting Started with Redstone page under the Support tab on the AppraisalWorld website 
located at www.AppraisalWorld.com.   

 

Once the startup tasks are completed, it is advisable to complete a couple of tutorial analyses before 
completing an actual analysis. To access the Practice Tutorials, go to Tutorials -> Practice Properties. 
 

 

Starting an Analysis 
Open Redstone and select New Analysis under the File drop down menu. 

You will be asked to login to create the account. Use the same password that is 
used to login to your AppraisalWorld account.  

 

Suggestion: Starting with the end in mind, you may want to review the report pages near the end of this 
document.  

  

Note: If the login does not work and you get an error, you may need to link the Redstone 
application to your AppraisalWorld account.  This can be accomplished by accessing 
Appraiser Setup under the Help dropdown Menu. Follow the prompts to completion. 

Note:  To Create a Redstone Analysis:  

 A credit card must be on file in your AppraisalWorld My Office account.   
AND YOU MAY ALSO 

 Purchase a 10 pack of Redstone Analyses from the AppraisalWorld Store.  

http://www.appraisalworld.com/
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Address Verification 
The first window to appear is Address Verification  

 

The following steps and options are available: 

a. Enter the Subject Property address. 
b. Click the Locate and Verify Address button (you may have to manually move the Subject marker to the 

correct location. Left click and drag the Subject marker to the correct location and place it on the 
center of the subject property home).  

c. Displays the verified address that will be used within the report. 
d. Click Show Birds Eye View to display (where available) a 45% view of the property.   
e. The navigation tools within the Birds Eye View and Ariel View can be used to zoom in “+” and 

out “–“. Birds Eye view has the added ability to use the curved arrow keys to the left and right 
of the compass to rotate the Subject property. 

f. Independent will appear here for the Redstone Reports you create and for actual reports you 
create.  

g. Reference Numbers. 
h. Enter the Effective Date of the Appraisal. 
i. Select Desired Report (more reports may be added to Redstone in the future). 
j. Click the Start Analysis button to continue.  

  

Note: If the Start Analysis button is greyed out, your address did not verify. Check the box in front of 
Address Verification on the left side of the window to activate the Start Analysis button. 



 

 Page 4 of 40     
      

 

Order Confirmation 
 

  
 

If the Address, and/or Report Type are incorrect, click No and go back to the Address Verification window to 
make your corrections.  

Once all information is correct, click the Yes, Authorize Charge button again and credit/debit card is billed. 
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Overview of Drop Down Menu Bar 
Below are the options available under the primary drop down menus. For the sake of time, most are typical 
and will not be covered here. 

 

Important Menu Options:  

a. Edit: Copy Redstone Analysis copies report pages onto the clipboard for import into ClickFORMS 
(exclusively for ClickFORMS users). For those who use other form filler software, simply add a PDF 
of the Redstone Addendum to your report.  

b. Orders: Links to the AppraisalWorld Order Manager.  
c. Window: Display multiple Redstone Analyses as a Cascade, Tile Vertically and Tile Horizontally.  
d. Help: To Check What’s New for recent enhancements, fixes and current issues. 
e. Help: To access this User Guide (This document). 
f. Help: To access the Regression Overview (Step-by-step walkthrough of Regression). 
g. Help: Request Support opens a window for forwarding a support request. 
h. Help: Send a Suggestion opens a window for forwarding a suggestion to the Product Manager. 
i. Help: Download TeamViewer will transfer you to the TeamViewer download link if remote access is 

requested by tech support. 
j. Help: AppraisalWorld opens the AppraisalWorld website within your default web browser. 
k. Help: Appraiser Setup opens the Appraiser’s AppraisalWorld user profile for editing Appraiser 

profile information.  
l. Help: About Redstone opens a window and displays the current version and release date 
m. Tutorials: Practice Properties opens the tutorial selection window. 
n. Tutorials: Check MLS Data Import opens a tool to check an MLS import for missing data fields.  
o. Tutorials: Guide to How to Test your MLS Data Import for missing fields. 
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Overview of the Analytic Process 

 

There are five main steps in completing a Redstone Analysis: 

1. Subject: Entry and verification of the Subject Property information. This information comes from public 
data records and can be edited as needed. Here you’ll also find a Location and View influence map to 
assist in identifying any external factors surrounding the subject property. 

2. Data Import: Import MLS data, review and edit property data.  

 Sales and Listings Distribution displays where the subject lies in the market based on 
characteristics. 

3. Comp Selection: Use neighborhood boundaries, feature ratings and filters to identify the properties 
that are most comparable to the subject property. 

4. Analysis:  

 Overall Market data analysis. 

 Regression analysis of the included sales to help determine adjustments. 

 Subject Market Trends for the 1004MC report page. 

 Adjustments (The adjustments do not transfer into ClickFORMS. The Adjustments will be used 
during the creation of appraisal reports to be included in future Redstone releases).  

5. Value Indicators: Compare your Value Estimate with the Regression Analysis and other sources to 
determine if your Value Estimate is higher or lower compared to the other available resources.  

6. Report: Display of the report pages and the creation of market area maps.    
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Process Tab 1: Subject  
 

 
 

The Subject tab provides you with the opportunity to verify and edit the subject property data brought in from 
public records. 

a. The Address and geo code is shown here and cannot be changed once the order has been submitted.  
b. Enter a numeric value for these “Component of Value” fields. This data will be used within the 

Regression Analysis and the filtering of comparables under the Analysis Tab.   
c. The Location and View Influence selected on this window will transfer into ClickFORMS and Redstone 

UAD report forms. These fields may appear in various other Redstone Reports. 
d. This map provides you an image of the area surrounding your subject property. This will assist you in 

identifying any external factors surrounding the subject property. 
e. Use the Navigation Tools to navigate the map image. If your mouse has a roller, you may use it to zoom 

in and zoom out on the image.   

The fields highlighted in green do not display in the Redstone Analysis. They do transfer into ClickFORMS. 
Note: These fields may also be included in other Redstone Reports to be included in future Redstone releases.  
Non-ClickFORMS users can use these fields for reference.   
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Process Tab 2: Data Import  
This section provides for importing the MLS Sales and Listings file you create within your MLS into Redstone.  

We will divide the two processes taking place under the Data Import tab: MLS Import and Define Market 
Area. The MLS Import process:  

Import your local MLS data into Redstone and review for data errors.   
 

 
 

a. Click the Import MLS button.  
b. In the Import MLS Data File window select 

your MLS System State.  
c. Select your MLS System Name. Redstone 

remembers your last selection. 
d. Select SFR or Condo radio button depending 

on what type of property you are analyzing. 
e. On the lower left side of the window, click 

the “Add MLS name to Data Source field” 
checkbox.  

f. Click the Browse button to locate your MLS 
data file. Once you select the data file, you 
will see the name of the file in the Data file 
exported from MLS System field.  
Note: The data import will automatically 
begin once the file is selected without having to click the Import MLS button.  

g. The Number of Errors and the Number of Duplicates are shown to the right of the Import MLS 
button.  

h. Fine Next Error button opens a dialog box for correcting MLS data errors. It will be covered in 
the next page. Check the box to display the Comments column below. 

i. Exclude Duplicates removes the most likely duplicate highlighted properties (if you prefer, you 
may also review them and manually select which property to remove). 

j. Delete Excluded removes all excluded properties and Excluded Outliers from file permanently.  
k. Displays the number of Imported Sales, Imported Listings, Excluded and Remaining. 
l. Export Data is an optional function to export the cleaned MLS data to a separate comma 

separated value (.csv) data file.  
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MLS Data Verification  

This message below will appear if the subject property is included within the MLS data import. The appraiser 
has the option of removing the subject property, highlighted in red, from the MLS import within the MLS Data 
Verification window.  

 
 

You have the option of scrolling through the properties and uncheck the Subject Property to remove it from 
consideration 
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MLS Data Verification   

Find Next Error function provides options for reviewing and correcting imported MLS data.  
 

 
 

a. Yellow highlighted data is the data currently presented for verification. 
b. Red highlighted data fields are those fields that will need verification.  
c. MLS Data Verification window provides multiple options for correcting or bypassing the data 

issue. 
d. The address of the property address that contains the data issue. 
e. The column header that contains the data issue. For example, Garage Cars. 
f. Display area for the data issue to be resolved.  
g. Enter the correct value in the New Value field. 
h. Check/uncheck to save/not save your edits for automatic use for future data imports. 
i. Replace the data displayed in area f with the information displayed in h. 
j. Replace All the data errors with the data displayed in area f in the column e with the 

information displayed in h.  
k. Skip the specific data error displayed in f for the property d. 
l. Skip Column ignores all data errors for the column e. 
m. Exclude Property removes the property from the data to be transferred into the analysis. If you 

decide to exclude a property from the analysis, be sure that it is not a potential comparable.  
n. Cancel stops the data review process and returns you to the Data Verification window.   

The process can be resumed by clicking the Find Next Error button.  

 
 
  

Note: Use caution in making corrections as corrections to Fireplaces, Garages, Carports, Pools and 
Spas are recorded. When the same unrecognized entry is encountered again, your previous correction 
will be used to replace the unrecognized entry.  
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MLS Data Verification - MLS Automatic Changes Review 
 
When you are ready to import by clicking Save and Close, you will be given the option to review and confirm 
the edits. You can edit the information in the New Value column if needed, then click the OK button. 
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Process Tab 2: Data Import, Define Market Area (optional) 
 
Creating a Market Map Area Map is an optional Process.  
 

 
 
The following buttons and information is shown on the right side of the Data Import window: 
 

n. Define Market Area opens the Market Library. 
o. Refresh Map is self-explanatory. 
p. Sales and Listing Outliers indicates the number of properties the lie outside the Market Area. 
q. Map Legend defines the property indicators on the map. 
r. Exclude Outliers opens a dialogue box like the one shown below for selecting Sales and/or Listings to 

be excluded from consideration within the analysis.  

 
 

s. Sales Distribution provides graphic information of the distribution of sales within the market area in 
comparison to the subject property. 

t. Listing Distribution provides graphic information of the distribution of listings within the market area 
in comparison to the subject property. 
 

Market Distribution shows the distribution of the Sales and Listings across various Market Characteristics 
including: Sales Price, Listing Price, GLA, Age, Site Area, Basement Area, Basement Finished, Bedrooms, Total 
Baths, Fireplaces and Car Storage. 
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Process Tab 2: Data Import, Define Market Area (optional) 
 

 

a. If you have previously created a market boundary for a property near your current Subject, Redstone 
will select that previously defined boundary for you. If there are more than one previously created 
boundary maps, Redstone will alert you to the number of maps. You may select one of the maps by 
double clicking the desired map in the Map Library. This will transfer the map and close the Market 
Library window.   

b. Click the New Map Button to create a new neighborhood boundary map.  
c. Left click the mouse button and Release to set the first point of the boundary. Continue the process to 

set points around the boundary. Double click the last point to stop the process 
d. Once completed, any of the corner edit points can be moved. Hover the cursor over a point and when 

the cursor turns into a finger, click, hold and move the point to the desired location.  Two additional 
target points will appear, one on each side of the moved point, providing additional adjustment 
options.  

e. If you make a mistake and need to start over, click the Clear button and redraw your boundary  
f. When complete, enter a Name in the space provided and click the Save to Database button. 
g. The Center button centers the current map with the Subject Property at the middle. 
h. The Edit button allows you to edit the map currently displayed. As you roll the mouse over the shaded 

area, the map boundary becomes bold. Click the shaded area and the edit corner points are displayed.  
To complete the editing process, click the Edit button. The edited map can replace the current map or 
as a new map. Be sure to enter a new name in the Name field provided before clicking the Save to 
Database button.  

i. Click the Transfer Map button to transfer the map displayed to the analysis and close the Market 
Library window.  

j. To leave the screen and abort any changes made, click the X in the upper left hand corner.  
 



 

 Page 14 of 40     
      

 

Process Tab 2: Data Import, Location Map 

The Market Boundary Map is shown on both the Data Import and Comp Selection. Based on if you are in the 
Sales or Listings tab, the corresponding dots will show on the map.  Note the following:  

 

a. Rank sorts the sales and listings by their Rank order. 
b. Hide Map clears the map on the left side of the window allowing more room for the Sales and Listings. 
c. Show Ranking Preference hides the Map and brings up the Ranking and Filters functions shown in the 

following pages. 
d. Map Legend defines the property indicators on the map. 
e. The Red dot is the Subject Property. 
f. A single click on a dot on the map or on a property address line (on the left): 

 Gold highlights the corresponding property. 

 Gold dot indicates the corresponding property location on the map. 
g. The legend shows the Property Type for each color dot displayed on the map.  

Comp Selection: MLS Data grid 
The Comp Selection tab is separated into two sections; Sales and Listings.  

 

 
 
If you do not want a particular property to be considered as a comparable or for further analysis of the 
market, you may manually exclude it by unchecking the box in the Include column: 
 
 

  

Note: Clicking the column header of any colum will sort the properties from either high 
to low or low to high based on the data contained within that column.   
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Process Tab 3: Comp Selection: Ranking Preferences 

To assist you in the selection of comparable properties in relationship to the subject properties, it is necessary 
to set the Ranking Preferences and Filters.  BOTH Sales and Listings are Ranked and Filtered at the same time.  

 

Feature Rating is the process used to bring the most likely Sales and Listings comparables to the top of the list. 
The Sales and the Listings are now ranked and filtered at the same time. 

Moving the slide bars dynamically changes the Rank for the corresponding column. The final Rank Score (d) is 
calculated by adding the Near Score (a) + the Match Score (b) + the Weight Score. An automated value is 
added to a Comp when a Comp # is set for the property. The added value moves the Comp to the top of the 
list. This only occurs when a Comp # is set for a property.  The added value is taken away if the Comp # is 
removed from the Comp reverting back to its original Rank. 

a. The Near score combines the ratings for Proximity and (Date of Sale for Sales and Listing Date for 
Listing Comps) and is highlighted in blue on the right side of the window. Moving the sliders 
increases and decreases the significance of each of the characteristics displayed.  

b. The Match score is a combined rating of characteristics and is highlighted in yellow. 
c. Click the v to the right of the blank in the first column to select and enter the comp number for the  
d. Properties highlighted in blue are the properties removed using the filters or deselected from the 

list of potential comps.  
 

The Feature Rating and Filter settings will be saved with the report. The Feature Rating settings will be used 
the next time the Redstone report is opened.  
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Process Tab 3: Comp Selection: Ranking Preferences (Continued) 

 

 

 

  

Note: The Near Score for Date of Sale is determined by how long ago the sale was 
completed. High is closer to the Effective Date, Low is further from the Effective Date.  
Same concept applies to Listing Date; High is closer to the Effective Date, Low is further 
from the Effective Date.  

Appraisers are advised to check and verify the settings during the selection of 
comparable properties for each Redstone report as the previous settings will be used to 
automatically sort the Sales and Listings.   
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Process Tab 3: Comp Selection – Filters tab 

 

Filters remove properties (the less likely comparable prospects) leaving the most likely comparables for 
consideration.  Your local knowledge of the market area is vital in guiding the filtering process.   

a. Indicates the total number of sales and listings, number excluded and number remaining.  
b. The Subject Property data is shown in the middle columns and the Minimum and Maximum indicates 

the highest and lowest value within the database. 
c. Clicking the arrow next to the box lists the available filter types. Select the filter and appropriate boxes 

will show up in area (e).  Filters include:  

 Filter Off 

 Less Than 

 Equal To 

 Greater Than  

 Between (See Note on bottom of next 18) 
d. Click the Apply Filters button after setting each filter and view area (a) to verify the number of 

properties remaining for use within the report.   
e. Click the Reset button to set all Filters Off. 
f. Type in the number for high and low. Use the up and down arrows 

for fine tuning. If too many properties are excluded, you can 
widen the parameter by using the up and down arrows. Click on 
Apply Filters (b) and all the properties are filtered based on the 
new criteria. 
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Process Tab 3: Comp Selection – Filters tab (continued) 

 

Here, additional filters were used to narrow the list of Sold and Listed properties to a manageable size. We 
suggest that you Apply each filter before proceeding to the next filter.  

The filters applied in this example will limit properties to those Less Than 1.0 miles of the subject property, 
sold or listed Less Than 180 days, with Gross Living Area Between 1800 and 2600 sq. ft. and Equal to 1 story.   

As each filter is applied, you have the option of expanding or contracting previously applied filters on this 
screen.  

a. Click the Show/Hide Ranking Preferences button and the Show/Hid Map to fully show the work area 
and Click the desired Sales/Listings tab. 

b. Adjust the desired Filters to refine the list of available Sales and Listings. 
c. Click on the Down Arrow and select the Comp number for the selected property. To Clear the 

selection, open the drop down box and select Clear to remove the number from the selected property. 
d. Uncheck the checkbox to remove a property from consideration as a possible comparable. Click Rank 

to move the property below the list of considered properties 

Numbered Sales Comparable, Feature Ranking and Filter settings will be shown on the the third page of the 
report, Compable Sales Selection Methodology.  

 

  

Note: The Filter settings used to identify comparable, will be forwarded and used to 
identify properties for the 1004MC. Adjust the filters under the Comparable Properties 
tab to increase or decrease the list of properties to be included in the 1004MC.   
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Process Tab 3: Comp Selection: Property Details (Optional) 
 
The Property Function provides detailed MLS information comparing the potential comparable property side-
by-side with the subject property. 
 

 
 

a. Double clicking a property address brings up a window displaying additional data you imported from 
your MLS.  

b. Click the and buttons to advance to the next comparable or go back to the previous 
comparable 

c. The appraiser can make corrections to the comparable property data. Click the  button to save 
the changes before leaving the Property detail window for the edited property. 

d. Click the  button to close the Property Detail window and return to the Comp Selection 
window. 

 

  

Note: If the comps are sorted by address or other field to locate a comp, and the comp is 
not currently selected (highlighted in blue):  
1. Check the check box to include  
2. Click the Rank button  
3. Locate the property and assign a comp number to the property.   
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Process Tab 4: Analysis   

In the Analysis tab, you will be able to use Regression, Ranking and Filters to process the data. At the end of 
the process you will have many of the components of value adjustments derived from the Regression 
Analysis.  You will also have a report page that documents your weighing and filtering of the available 
comparable. The 1004MC data is analyzed and displayed in the 1004MC form under the Report tab.  

Below is an overview of the various operations available under the Analysis process tab.  

 

a. Overall Market breaks down monthly statistics for all the sales and listings imported into the 
analysis and an overview is displayed on the first page of the report, the Market Summary.  

b. Regression calculates adjustment ranges for various components of value and forwards the 
adjustment ranges to the fourth page of the report, Market Adjustment Factors.  

  

c. Subject Market provides filters that reduce the list of properties to meet the requirements of 
the 1004MC and the resulting data is forwarded to the fifth page of the report, the FNMA 
1004MC. 

d. Adjustments document the components of value for use in the valuation sales grid.  
A number of options for calculating Time Adjustments have been added under this tab and will 
be covered in detail.  

  

  

Note: Those components of value with a p-value of less than 0.05000 are considered 
statistically significant and may be forwarded to the Market Adjustment Factors report 
page if you opt to do so. There is a checkbox on the Regression tab that allows you to 
send all components or only those with a p-value of less than 0.05000. The closer the 
value is to 0.00000, the higher the statistical significance of the Most Probable Value and 
the adjustment range.  

Note: Non ClickFORMS users may want to select a Time Adjustment option for 
calculating time adjustments for the Sales Comps that will appear on the Adjustment 
Factors page of the report.  

The remainder of the information under this tab is For Reference Only. 
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Process Tab 4: Analysis - Overall Market tab 
The chart and graphs shown below pertain to the total properties brought into Redstone.  This information is 
to help you to view the overall market as compared to the limited data used for the 1004MC.  The information 
shown on the Market Summary, page one of the report, comes from the information shown here. 

 

a. Detailed Market Analysis: Each line item is also shown as a graph below.  
b. Use the scroll bar on the right of the window to view each of the graphs that illustrate each line 

of the Market Analysis. 
c. Check this box to Treat Pending Sales as Settled Sales. 
d. You may select trend lines for, the last 12, 6 or 3 months to assist you as you interpret the data. 

Here you can determine if the trend is increasing, decreasing or stable.   
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Process Tab 4: Analysis - Regression tab 
A preliminary analysis has been run against the data and outlying properties were removed from the list of 
available properties. The properties are listed to the left with the removed properties unchecked and 
highlighted in blue. 

 

a. Indicates the total number of sales and the remaining number after exclusion of the outliers. 
b. Press the Run Analysis button after a line item has been removed from the list in area f (See Note 

below). 
c. The Subject Property Indicated Sale Price by Regression:  

 It is shown here for your reference only and is NOT shown within the report.  

 This is a baseline value and ranges from the amount shown plus or minus the standard error.  
For example, if the value shown is $100,000 and the standard error is 10% or $10,000. Then the 
baseline value plus or minus the standard error ranges from$90,000 to $110,000.   

 Regression does NOT predict value.  It is setting a baseline value based upon the others sales 
within the selected neighborhood.   

 The subject properties location, view, condition and quality are not factored into the analysis.  

 As the analysis is based on sales for the past year, an increasing or decreasing market will affect 
the indicated value of the subject property.   

d. A scatter-plot showing the point where each property included in the analysis falls on the graph based 
upon its Actual Sales Price and Predicted Value from regression. 

 Actual Sales Price is the horizontal X-axis and Predicted Value is the vertical Y-axis.  

  

Note: Pressing the <CTRL> key on your keyboard and clicking the Run Analysis button at the same time will 
apply the currently checked components of value to All the available properties and automatically remove 
outliers. This is a reset of the automatic removal of outliers using a consistent methodology. 
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Process Tab 4: Analysis - Regression tab (Continued)  
 

 

e. There are two actions that will result in a distribution of properties that will resemble a bell curve 
within a regression: 

 The initial number of properties included within the regression analysis without using constraints 
(size, age, price and configuration). 

 The removal of outliers (properties whose predicted accuracy are +/- a significant percentage from 
100% accuracy).  

f. The list of the Components of Value, variables, showing Most Probable Value, Probable Value Range, 
P-value and check boxes for excluding specific variables.  

 The components of value with inflated value or high p-values may be removed from the 
analysis.  

 Components of Value highlighted in yellow may be indicating a negative value.  

 Year Built should be a negative value.  

 The Sale Date value may be negative or positive depending on the market.  

 The other components of value typically are a positive value.  
g. Display of the Confidence level of the Statistical Measures.  
h. Properties displayed in blue are outliers removed from the Regression Analysis. 
i. Removing the Checkmark in the Checkbox allows all of the values listed on the left to be transferred. 

Remove any adjustments that you do not want to have displayed on the Adjustment Factors Report 
page.  
This option has been added as requested by appraisers. Redstone’s default setting ONLY display 
components of value with a p-value of less than 0.05000 to be considered statistically significant and 
forwarded to the Adjustment Factors report page. The closer the value is to 0.00000, the higher the 
statistical significance of the Most Probable Value and the adjustment range. 

 

Note: A Regression Overview document containing information on how to refine your 
analysis is available under Redstone’s Help dropdown menu.   
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Process Tab 4: Analysis Subject Market – Competing Properties tab, Filters 

 
 

 

The Comp Selection filtering is forwarded to this tab. The Sales and Listing comparable shown are the same 
as those used for Comp Selection. Adjust the filters to broaden the number of properties to be included in the 
1004MC.  

This process provides filters for reducing the list to include only those properties needed for the completion of 
the 1004MC.  

a. Running totals showing the total number of sales and listings, number excluded and number 
remaining.  

b. Displays the Subject Property data in the middle columns and the Minimum and Maximum values of 
the properties in your data set. 

 

 
  

Note: The Filter settings used to identify comparable, are shown and are used to identify properties for the 
1004MC. Adjust the filters to increase or decrease the list of properties to be included in the 1004MC.   
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Process Tab 4: Analysis, Subject Market – Competing Properties tab, Filters (Continued) 

 

c. Clicking the arrow next to the box lists the available filter types. Select the filter and appropriate boxes 
will show up in area (e).  Filters include:  

 Filter Off 

 Less Than 

 Equal To 

 Greater Than  

 Between (See Note below) 
d. Click the Apply Filters button after setting each filter and view area (a) to verify the number of 

properties remaining for use within the report.   
e. Type in the number for high and low. Use the up and down arrows 

for fine tuning. If too many properties are excluded, you can 
widen the parameter by using the up and down arrows and click 
Apply Filters and all the properties are filtered based on the new 
criteria. 

f. Click the Reset button to set all Filters to Off. 
g. Displays the breakdown of the 1004 MC calculations using the included properties 

 
 

 
 
  

Note: The number of bathrooms are currently rounded up. This issue has been reported and 
will be updated to reflect partial baths in a future release.  For example. If the Subject 
Property has two and a half, 2.5 bathrooms, the chart will display 3 bathrooms.   
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Process Tab 4: Analysis, Subject Market – Trends tab 
 

 

The charts and graphs display results for sales and listings remaining after applying filters under the 
Competing Properties tab.  

a. Effective Date is the date used within the analysis to determine all time calculations.  
b. Check this box to treat Pending Sales as Settled Sales. 
c. Sets the option to calculate trend lines shown in area (g): 

 Previous 12 months 

 Previous 6 months  

 Previous 3 months 

 Hide Trend Lines 
d. Determines the tipping point for switching the bubble indicator from stable to increasing or 

decreasing. For example: Setting the percentage to less than 5% would show -4.99% to 4.99% as stable.  
e. Rate and % change based on the time period of the trend line in area (b). 
f. Subject Market Trends radio buttons are initially set based on the calculations as shown in area (d) 

within the limits set in area (c). The radio buttons can be manually changed by the appraiser. The 
results will be forwarded to the 1004MC report page.  

g. A graph is shown for each line of the chart above.  The Trend Lines are shown as set in area (b) 
(calculated by previous 12 month, 6 month and 3 month trends). Use the scroll bar at the right of the 
window to scroll down to view all of the charts.  

h. You may opt to turn off Trend Lines as this may help to make the chart less cluttered. This has no 
impact on the period covered by the Trend Line as set in area (b) or the calculations shown in area (d).  

i. The 1004MC chart calculations are shown at the bottom of the window. 
 
 
  

Note: Selecting “Hide Trend Lines” defaults to showing the Rate and % Change in area 
(b) to a 12 month period.  The Rate and % Change are NOT displayed within the report 
and are provided to assist you in determining Market Trends.   
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Process Tab 4: Analysis – Adjustments tab 
All of the Adjustments, with the exception of the Time Adjustment, displayed on this window are “For 
Reference Only.” You may enter the adjustment amounts you intend to use within the appraisal for future 
reference. As the Time Adjustment is a unique adjustment, it will be covered separately on the next page.  

 

a. A Check Mark in this column indicates the adjustment is Active and will be used in the comparison grid 
(future enhancement). 

b. The per-unit amount is entered/shown in the Adjustment Factor column.  
c. The Only If Greater Than field allows you to enter a difference that must be exceeded for the 

adjustment to occur.   
For example: The adjustment of $50 per sq. ft. only if GLA is greater than 100 sq. ft.  

 0 to 100 sq. ft. +/- , no adjustment for this difference.   

 101 sq. ft. would +/-, $50 per. sq. ft. x 101 sq. ft. = $5,050. 

 The adjustment starts at 1, once the difference criteria is met.  
d. If the Use Regression Factor checkbox is selected, the Most Likely Value adjustment from Regression 

will show a check mark in the box under (a) and the Most Likely Value will show in the Adjustment 
Factor field (b). If the Regression Analysis is further edited, the Regression Factors’ Most Likely Value 
will change to reflect the updated Regression Analysis.  

e. The color coded squares also indicate the confidence level of the p-value: 

 Green is good    

 Yellow is fair  

 Red is low    
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Process Tab 4: Analysis, Adjustments tab – Time Adjustments 
 
All of the Adjustments, with the exception of the Time Adjustment, displayed on this window are “For 
Reference Only”. You may enter the adjustment amounts you intend to use within the appraisal for future 
reference.  

The Time Adjustment has been expanded to provide four different options.  

 

Click the Radio button in front of the Time Adjustment option.  Resulting adjustments for the first six comps 
will be displayed on page four, Market Adjustment Factors. Check the radio button in front of one of the 
options. The amount of the monthly adjustment is shown in box a and the Checkbox is checked to indicate it is 
an active adjustment. 

a. Monthly Dollar Time Adjustment for selected Comparables. 
b. Appraiser Defined Adjustment: Entering a monthly dollar adjustment amount in the empty box b will 

set the monthly adjustment in a.   
c. Regression Results Adjustment: Selects the monthly regression dollar adjustment shown in c as the 

monthly adjustment in a.  
d. Sales Price Trend line:  Selects the dollar adjustment in d as the monthly adjustment in a.  

Graph is shown. The amount is calculated by taking the difference between the beginning and end of 
the previous 12-months and dividing the difference by 12.  

e. Monthly Difference in Median Sale Prices: Using the sales comparables within the selected market, 
the percentage difference between the Median Sale Price of the month of the Effective Date and the 
Sale Date is used to determine an adjustment amount for each month.  The month of the sale of the 
selected comparable determines the adjustment percentage (use caution when using this option with 
small samples as the recommended monthly adjustments will vary dramatically). 
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Process Tab 5: Value Indicators 
This grid provides you with a visual of the Value Estimate you entered into field A with the values derived 
from the regression analysis. Zillow and other valuation indicators may be available in future releases.   

 

The information recorded here is for your records and is not part of the final report.  It is backup data for your 
work file in the event some aspect of the appraisal report is questioned. Below is information on how the 
Appraiser’s Value Estimate was determined. 

The charts on the right of the screen, compares your Value Estimate against the distribution of Sales and 
Listing prices included in the analysis. The subject property is represented by the Green bar, on the chart. 
 

a. Enter estimated value of property and click Add to Charts. 
b. Graph displays the Appraisers Estimated Value and compares it to the Regression Analysis value and 

Zillow if available.  The Market Range end points, High to Low, are also displayed. 
c. Charts display the subject property in relation to the overall market distribution.  
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Process Tab 6: Reports 
The Reports tab is where all the pages of the Redstone Analysis are displayed. The following menu bar options 
are provided: 

 

a. The size of the page display can be increased or decreased using the up and down arrows to the 
right of the percentage display. 

b. Maps will load automatically each time the Report tab is accessed.  Select Manually Build Maps to 

manually create maps before transferring the analysis by clicking the button above each 
map.   

c. Map Labels (optional) are accessed by clicking on the  icon. 

Analysis Pages Include: 

1. The Market Area statistics report page contains all the sales and listing information displayed under 
the Analysis – Overall Market tab. 

2. The Market Characteristics report page contains the histograms from the Market Data – Distribution 
tab.  

3. The Comparable Sales Selection report page contains the Feature Ratings, Filters and Comparables 
selected under the Analysis – Comp Selection tab. 

4. The Market Adjustment Factors report page contains: 
a. Regression and Adjustment Values from the Analysis – Regression tab.  
b. Comparable Time Adjustments from the  Analysis Trends tab. 

 Regression Components of Value as defined by the appraiser, are included in the report. 
5. The 1004MC report page contains the information from the Analysis – Subject Market - Trends tab. 

a. Information is from Analysis – Subject Market – Trends.   
b. The text narrative is created using the Information from Analysis – Subject Market – Trends. 

6. The Market Trends report page displays the charts from the Analysis – Subject Market – Trends tab.   
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Page 1: Market Area Statistics 

 
 

a. Redstone automatically presents the map on the page. If you need to edit it, click the Create Map 
button to bring up an area map. Control keys are provided to position, zoom in and out.   
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Page 2: Market Characteristics 
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Page 3: Comparable Sales Selection 
Under Top Sales Analyzed, you’ll see the properties that you selected as your Sales comparables as well as 
other properties that you reviewed, but did not select as a comparable. The properties appear in ranked order 
up to a total of 20 properties. This page shows the methodology by which the comps were selected.  
 
Also, you may comment as to why you did/did not select a particular property as 
a comparable, in the Comments field. To save a comment for future use, input 
the comment, right click in the field and choose Save as Response. 

 
a. Redstone automatically presents the map on the page. If you need to edit it, click the Create Map button 

to bring up an area map. Control keys are provided to position, zoom in and out.    
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Page 4: Market Adjustment Factors 
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Page 5: Market Conditions Addendum 1004 MC 
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Page 6: Market Tends 
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Transferring Redstone Analysis into your 1004 or 2055 as Addendum Pages  

ClickFORMS Users 
It is recommended to start your 1004 or 2055 report in Redstone and then transfer into a blank template or 
clone. Make sure you have the latest ClickFORMS version (v8.7.5).  
 
ClickFORMS users:  
Follow the processes below to transfer the analysis to your 1004 and 2055 reports:  
 

 
 

 
 

 Within Redstone, Save the Redstone Analysis before using Copy. 

 Select the Edit > Copy Redstone Analysis function.  

 Open ClickFORMS.  

 Select the Edit> Paste Redstone Analysis function to complete the transfer. 
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Other Appraisal software: (PDF Creation) 
Follow the processes below to transfer the analysis to your 1004 and 2055 reports.  
 
 
 
 
 
 
 
 
 
 

 
 
 

 Click File > Create Adobe PDF function  

 In the Create Adobe PDF File window select the report pages you want to include in your 
analysis addendum.  

 Import the PDF file into your 1004 or 2055 report as addendum pages using your software 
providers PDF import instructions.  

 The PDF file is stored in the Libraries>Documents>My Redstone>PDF files folder.   
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Redstone Files and Where They Are Stored 
The primary Redstone files you will need to access are stored in the following folders:  

 

a. The My Redstone file folder is located under Libraries>Documents>My Redstone 
b. It is recommended to place the MLS export files into the MLS Imports folder 

 This is the default folder for the MLS import tool 

 Once the MLS data has been imported into Redstone, you will see a prompt asking you if you 
want to move MLS export data file to the archive folder 

 Click Yes and the file will be moved to the newly created MLS Archive folder.  

 Following this process minimizes the risk of an old file accidently being re-used.  
c. PDF Files of Redstone Reports are saved to this default file folder  
d. Redstone Reports (.REDX file format) are automatically saved to this default file folder. This report file 

is your electronic work file. The Backup folder is also located in the Reports folder. Here you’ll find 
your Backup files (.bak) in the event that you need to restore a file. 

e. The User License file(s) are stored in this file folder 
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DEFINITION OF STATISTICAL TERMS 

Definitions 

DEFINITION OF R-SQUARED (Coefficient of Determination): In regression analysis, a measure of the strength of the relationship between the independent variables 
and the dependent variable. The measure ranges from 0 to 1 - the higher the number, the stronger the relationship (0 would indicate no relationship) 

DEFINITION OF ADJUSTED R-SQUARED: R-Squared can overstate the goodness of fit in a model when insignificant variables are included, or the number of variables 
R-Squared appropriately. 

DEFINIITION OF P-VALUE: A particular statistic that measures the significance of a variable in a regression analysis. The statistic is important in inferential statistics for 
hypothesis testing in regression analysis. The P-Value is a measure of the randomness of a component used in the regression analysis. 

DEFINITION OF COV (Coefficient of Variation): A standard statistical measure of the relative dispersion of the sample data about the mean of the data; the standard 
deviation expressed as a percentage of the mean. 

DEFINITION OF COD (Coefficient of Dispersion): The average deviation of a group of numbers from the median expressed as a percentage of the median. 

DEFINITION OF STANDARD ERROR: A measure of the precision of a measure of central tendency, the smaller the standard error, the more reliable the measure of 
standard tendency. In regression analysis, the standard deviation of a regression coefficient, the smaller the standard error relative to the coefficient, the more 
reliable the coefficient. 

DEFINITION OF SALES RATIO: A measure of model accuracy that divides predicted values by sales prices. The closer to 1 that a sales ratio is, the better the model's 
predictive capabilities 

DEFINITION OF STANDARD DEVIATION: The statistic calculated from a set number by subtracting the mean from each value and squaring the remainders, adding 
together all of the squares, dividing by the size of the sample less one, and taking the square root of the result. When the data are normally distributed, one can 
calculate the percentage of observations within any number of standard deviations of the mean from normal probability tables. 

Sources Documents 

The Collateral Valuation Report (CVR) has been designed in conformance with all available technology, data and statistical processes, generally accepted to represent 
the state of industry, including:  

Uniform Standards of Professional Appraisal Practice (USPAP): 
Standard 1 
Standard 2 

Since specialized statistical and mass appraisal information is contained with Standard 6 and Advisory Opinion 18, these sources have also been considered in 
tandem with the Development and Reporting standards contained within Standard 1 and Standard 2. It is expressly understood that the Collateral Valuation 
Report is a summary appraisal report performed under the guidance of Standards 1 and 2 as noted above. 

Joint Industry Task Force on Automated Valuation Models: 
Standards and Testing Guidelines 
These standards and guidelines are instructive in the method of testing accuracy and identifies the statistics and outcome guidelines that can be relied upon in 
performance of statistical analysis. 

International Association of Assessing Officers: 
Standard on Ratio Studies 
Mass Appraisal of Real Property 
Standard on Automated Valuation Models 

Appraisal Institute; 
A Guide to Appraisal Valuation Modeling 
Practical Applications in Appraisal Valuation Modeling and Design 
The 13th Edition of the Appraisal of Real Estate 

Visual Valuation: Implementing Valuation Modeling and Geographic Information Systems 

These texts form the body of knowledge that helps provide an understanding of the modeling process and the use of statistics in real estate. 

The Modeling Process 

An acceptable model will have both reasonable coefficients and satisfactory outcome statistics. The appraiser has been trained in a manner sufficient to understand 
the various statistical measures outlined in this report. The statistical measures defined within this analysis allow the appraiser to understand the data and draw 
certain conclusions based on the accuracy of the data, the amount and quality of the data, and the measures of statistical significance and accuracy of the analysis 
applied. 

Competence 

The appraiser completing the Collateral Valuation Report asserts that they have undergone sufficient training, and further, have an understanding of the statistical 
measures underlying the regression component of the process to generally understand the method and manner of analysis. The appraiser does not assert that they 
are statisticians. They are, however, aware of the basic guidelines pertaining to the use of CVR application as a tool to analyze small market datasets, and as such, are 
capable of understanding the analysis and methodology in a manner sufficient to render a credible estimate of value in tandem with the other data and analysis 
present in the report. 

The final value conclusion is the appraiser's own, and is based on the appraiser's knowledge and experience in the field of appraisal. The data and analysis in this 
report, whether through direct information or through derived statistical information, aids the appraiser in understanding the dynamics of the neighborhood and 
market area.  

Published 8/06/2018 


